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PMCAN Module

Engine Particulate Matter (PM) Measurement

Instruction Manual

Important Note

Due to the nature of CAN instrumentation, you cannot just physically connect a measurement
module to a bus and expect data from that module to be available. The pmCAN measurement
module has to be set up to send the data required and the receiving device (ex. data acquisition
software) has to know what is being sent. The setting up of modules and the production of a .dbc file
used by the receiving device to interpret the data sent is performed using the supplied Configuration
Tool (software) which runs on a PC.
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Quickstart Manual

The PM sensor has three conditions of operation: seeding, normal operation
and fouled. Seeding is necessary before normal operation begins and this will
typically take a clean and dry sénsor 4 minutes at 1.5 mg/m3. When the PM
level is‘doubled, the seeding time is halved. When the PM level is halved, the
seeding time is doubled. There will be a slight to moderate reseeding time
required each time the sensor (or engine) is stopé:)ed and restarted. Fouled
sensors can be identified by pinned or *“-1” PM and PN outputs and a VHV of
less than 900V. This requires that the sensor be blown out with air or cleaned
(see Appendix G).

Mount the sensor vertical so that water can drain out of it and just finger-
tighten it. The material it is made out of is a little sticky so the sensor won’t
unwind on its own. Make sure the mounting boss’s threads are clean and
straight before screwing the sensor in. Sometimes you’ll need a wrench to take
it out, so go easy. Wait until the sensor cools because it swells a little with
heat. The sensor’is made out of plastic so be gentle with it.

For best results, each time before dyou install the sensor, first blow it out with
compressed air for about 10 seconds.
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Complex measurement systems can be easily built with pmCAN,
LambdaCAN*, NOxCAN*, NH3CAN, and baroCAN modules. Here is a
five-channel lambda, O, and NOXx pressure-compensated, in-vehicle system.



Introduction

The pmCAN module kit is a compact PM (particulate matter) measurement device for use on
internal-combustion engines. The PM sensor looks like a spark plug, is screwed into the
engine’s exhaust pipe, and operates on a charge-transfer mechanism explained in the section
“How the PM Sensor Works”. The specifications for the kit are as follows:

Ranges: PM (Mass): 0.05 to 100 (Units: mg/m3)
PN (Number): 0.24 to 480 (Units: millions/cc (M/cc), ex. 0.24 M/cc is 240,000 #/cc)

Accuracy: £10%. Increased accuracy via user-entered delta tables.

PM Sensor Mounting: 18mm x 1.5mm thread, 22mm hex,
Sensor must be mounted pointing down and finger tight.

Maximum Exhaust Temperature for Sensor: 500 °C, 932 °F

Temperature Range for Electronic Module: -55 to 100 °C

Temperature Range for Cables: -55 to 220 °C

Minimum Bending Radii for Sensor Cable and Extension Cables: 100 mm
Module: 114 mm x 120 mm x 35 mm, 540 gm, Sealing Class IP27
Communication: CANopen, Programmable Baud Rate, Programmable Node 1D
Power: 6t032VDC,0.14 A @ 12V

pmCAN Kit Contents: See Appendix A

pmCAN Kits are normally supplied with a PM sensor P/N 06-10T which has been designed
for tailpipe applications. A PM sensor P/N 06-10E can be optionally supplied which has
been designed for diesel engine-out applications. P/N 06-10E is less likely to foul but has a
longer seeding time which may not matter for diesel engine-out applications where the PM
levels are higher.

Setup of the pmCAN kit is performed using the supplied PC software program called the
“Configuration Tool”. The Configuration Tool requires a CAN communication device to
communicate with one or more ECM CAN modules (ex. pmCAN, LambdaCAN%*,
NOXCAN*, NH3CAN, baroCAN, appsCAN) or analyzers (ex. NOx 5210, Lambda 5220,
EGR 5230, NH3 5250, miniSOOT 5260). While the tool is being used with modules, just
ECM modules set to stand-alone mode (see Appendix B) should be connected to the CAN
bus. While the tool is being used with analyzers, just analyzers should be connected to the
CAN bus. With analyzers, the Configuration Tool is just used to produce .dbc files.
However with modules, the Configuration Tool replaces the analyzer’s display head as the
user interface so it must do much more. This document focuses on using the Configuration
Tool with ECM’s pmCAN module.

The Configuration Tool supports four CAN communication devices: Kvaser, ETAS, Peak
USB-to-CAN adapters, and the VectorCAN CAN adapter card. The latest driver software for
one of these adapters must be installed prior to using the Configuration Tool. This software




will be supplied with the adapter or be available on-line. ECM’s Configuration Tool is
delivered on a CD or memory stick and is available for download from www.ecm-co.com

Once the adapter’s driver and the Configuration Tool software are installed, and with the
module(s) powered and connected to the CAN adapter, start the Configuration Tool software.
Click on the “Modules” tab, select the CAN adapter, select the baud rate (all modules
shipped from ECM are set at 500kbaud except if they are to be used in a miniPEMS where
they are set at 250kbaud), and click on the “START” button.

The software will identify the modules on the bus and display them in the “Module” field. If
this does not happen, make sure that the CAN bus is properly terminated (i.e. termination
resistors), that all modules on the bus are set to the same baudrate, and that baudrate is
selected in the Configuration Tool. Open the Module field to see all the modules on the bus.
If a module is not listed, one reason could be that its Node ID is the same as another module.
To resolve this, remove all modules except the “missing” one from the CAN bus, STOP then
START the software, and change that module’s Node ID. Another reason that a module is
not listed could be that the module is in EIB mode instead of stand-alone mode. All modules
must be in stand-alone mode.

To configure one of the modules (ex. change its Node ID) or to look at that module’s data,
you have to select that module in the “Module” field.

There are three things you can do with modules using the Configuration Tool:

1. Configure a module.
2. Look at data coming from that module in real-time and optionally log it.
3. Produce a .dbc file to be used by a device receiving module data.

Alternatively, 1. and 2. (above) can be performed by direct CAN communication with the
pmCAN module using user-written software. For information on how to do this and detailed
information about the modules, refer to the pmCAN Programmer’s Manual.


http://www.ecm-co.com/

How the PM Sensor Works

Figure 1 shows the structure of the PM (particulate matter) sensor. There are three concentric
metallic bodies: the outer shell, the high voltage (1000V) electrode, and the ground electrode.
When mounted perpendicular to the flow in an exhaust pipe, exhaust (with PM) enters the
sensor through an annulus in its bottom, passes up between the outer shell and the ground
electrode, then through holes and down between the high voltage electrode and the ground
electrode, and then out of the sensor through holes in the bottom of the sensor.

The simple explanation of how the sensor works is that PM flowing between the electrodes
strikes either the high voltage electrode or the ground electrode, is charged, and then is drawn
to the opposite polarity electrode where it gives up its charge, creating a current that is
measured by external electronics. This current is proportional to the density of the PM
flowing between the electrodes which is proportional to the density of PM in the exhaust.
More current means more PM (ie. mg/m3, #/cc).

The above is true with the necessary addition that the sensor has to have its electrodes
“seeded” with soot for the sensor to work. When a new (i.e. clean) sensor is put in the
exhaust, soot flowing through the sensor will attach to the electrodes and then to each-other
growing structures that look like little trees (i.e. dendrites). The dendrites on the two
electrodes will grow towards each other until the gap between the tops of the dendrites
reaches a threshold distance. This is called “seeding the sensor”. At this threshold distance,
any additional PM that strikes the dendrites on either electrode will break off pieces of the
dendrites which will be attracted and carry charge to the opposite electrode. The carrying of
charge across the electrodes via broken dendrites is measured by the pmCAN’s electronics.
The greater the concentration of PM flowing between the electrodes, the greater the collisions
with the dendrites, the greater the charge that will be carried across the electrodes, and the
greater the current that will be measured. This current is then correlated to the PM
concentration (i.e. mg/m3 and #/cc) in the exhaust and this calibration is stored in a memory
chip in the sensor’s connector.

Like trees in the wind, the dendrites in the sensor bend with flow. This causes interesting
flow-driven dynamics that have to be taken into consideration when interpreting the
pmCAN?’s reported PM:

1. When transitioning from a low flowrate to a high flowrate, the dendrites on the 1000V
electrode and ground electrode will bend over more. This will increase the gap
between the tops of the dendrites causing a momentary drop in PM signal until the
dendrites grow back up to the threshold distance again. The period of the momentary drop
is a function of the density of the PM in the exhaust. The lower the PM level, the
longer the drop.

2. Similarly, when transitioning from a high flowrate to a low flowrate, the dendrites on the
electrodes will bend over less. This will decrease the gap between the tops of the dendrites
and cause a momentary increase in PM signal as the dendrites are quickly “trimmed” to the
threshold distance.




3. When the engine (and hence exhaust flow) stops, the dendrites on the electrodes will point
directly at each other. This will substantially reduce the effective gap between the
electrodes and the high voltage across the electrodes will cause a slow “tree-trimming”
effect.

A sensor will be deseeded if it is blown out with compressed air, if it is left “on” in stationary
exhaust or air, or if it is struck by liquid water. How long it takes for the sensor to be
reseeded is a function of the density of PM in the exhaust and the exhaust flowrate. The
higher the density of PM and the greater the exhaust flowrate, the less the time for reseeding.

1000V

HIGH VOLTAGE >
ELECTRODE
GROUND .
ELECTRODE > .

FLOW INTO \, | y
SENSOR ***
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Figure 1: PM Sensor



Figure 2 contains a more descriptive diagram of the sensor and the external measurement
electronics. Note from the figure the following:

1.

The dendrites that look like black fur in the sensor. Broken off pieces of dendrites will
carry charge across the electrodes (resulting in “IST” current). These pieces may remain
on the other electrode, or trigger another dendrite break and charge transfer, or may exit the
sensor. PM entering the sensor will contribute to the regrowth of broken and lost
dendrites.

. There are three currents measured and reported: IST, ILK, and ITP. IST is the current that

is used to determine the density of PM in the exhaust. ILK is a leakage current from the
shield surrounding the lead to the high voltage electrode. ILK has a steady-state value but
will sometimes increase when the sensor is getting fouled (by PM or liquid). ITP is the
current used to create the 1000V measured on the input side of the transformer. ITP also
has a steady-state value and will increase when the sensor is getting fouled.

. There are two separate grounds: the one shown as a triangle and the one that is hatched.

The triangular one is used for the IST and ILK circuitry. The hatched ground is the ground
of the power supply used to power pmCAN. Actually, there is a third separate ground, the
ground for the CAN output.

. An electrical connection between the exhaust pipe the sensor is mounted in and the

ground of the power supply powering pmCAN is highly recommended because it often
lowers the background noise on the IST (and hence PM) measurement. This connection is
often the case with most vehicular applications, however, if the PM sensor is
mounted in a piece of exhaust pipe attached with a piece of silicon hose to the end of the
vehicle’s tailpipe, you will have to run some braided line from the piece of
exhaust pipe to the vehicle’s exhaust. In some dynamometer applications, pmCAN will be
powered by an external power supply. In these cases, you will have to run a piece of
braided line from the exhaust pipe the PM sensor is mounted in to the negative terminal of
the power supply powering pmCAN. When running on a set of chassis rolls, always
ground the vehicle and dynamometer to earth ground. (i.e. bleed off static electricity).

. In some cases, connecting the negative terminal of pmCAN’s power supply to pmCAN’s

metal enclosure via a braided line will lower background noise on the IST measurement.
Since pmCAN’s enclosure is anodized (and hence virtually non-conductive), you will have
to connect to a screw inserted into one of the two non-anodized screw holes on the back of
pmCAN in order to connect to pmCAN’s metal enclosure.

. PM can be positively, negatively, or neutrally charged. This is represented in Figure 2 by

the circles with “+”, “-*, or “N” in them inside the exhaust pipe and sensor.

. There is some parasitic coupling through the circuitry creating the 1000V. This will cause

some coupling between the triangular and hatched grounds.
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Figure 2: PM Sensor and Electronics



Application Notes

Safety Note: To avoid getting shocked by the 1000V applied to the sensor or possibly
damaging the pmCAN’s electronics, always turn the 1000V off before removing or attaching
the sensor from the cable (or the cable from the module). This is done using the Task:
“Toggle High Voltage”. When the indicator light on the front of the pmCAN is solid red, the
1000V is off. When the indicator light is solid green, the 1000V is on.

For the successful use of pmCAN, three issues must be understood: Seeding, Fouling,
and Sources of Error.

Seeding the Sensor: As described in “How the PM Sensor Works”, for the sensor to work, it
has to be seeded with PM. If the sensor is not seeded, it will report no PM. If the sensor is
insufficiently seeded, it will report a lower than actual PM concentration. The art to using
pmCAN is in keeping the sensor seeded. Here are some rules of thumb:

1. For the P/N 06-10T sensor, when the engine is at a PM level of 1.5 mg/m3 (7.2 M/cc),
seeding takes about 4 minutes. Half the PM level doubles the time. Double the PM level
halves the time.

2. A sensor will slightly deseed itself when the engine stops running or pmCAN is powered
down.

3. If the sensor is sprayed with liquid water (common during the first 15 minutes following
engine start-up), fuel, oil, or DEF (diesel exhaust fluid), it will sometimes deseed and/or
foul the sensor.

4. If the sensor is blown out with compressed air or is cleaned, it will be deseeded.

Fouling the Sensor: Fouling is the direct shorting (via carbon or a liquid) between two or
more of: the high voltage electrode, the ground electrode, or the shield (see Figure 2). Most
of the time, fouling occurs between the high voltage electrode and the ground electrode.
Fouling often occurs as follows:

1. First there will be spikes in the PM and PN readings (ie. intermittent fouling/shorting).

2. Then a steady short between the electrodes will occur resulting in PM and PN values
“pinned” at the upper range of the pmCAN.

3. The VHV will drop below 900V.

4. pmCAN will report an error and output PM and PN values of -1.

Liquid water fouling can occur during the first 15 minutes or so of engine operation (until the
exhaust temperature reaches approximately 80 °C) and will often occur after a large

acceleration (when liquid water is sloshed onto the sensor). Soot fouling can occur at high
PM levels.

Fouling can be minimized by mounting the sensor vertical (i.e. wires going up, holes in the
sensor pointing down).




Sometimes, the fouling will clean itself. It doesn’t clear in 15 minutes, the sensor will have
to be taken out of the exhaust and blown out with compressed air for about 10 seconds. In
extreme cases, the sensor will need to be disassembled and cleaned. Appendix G describes
how to clean the sensor which should take less than 5 minutes.

Sources of Error:

1. Effect of flow: Unfortunately, the sensor has a sensitivity to flow velocity. At a fixed
particulate concentration, the reported PM (and PN) will scale with flow velocity. For that
reason, the PM sensors have been calibrated at a mid-exhaust flow velocity.

2. Effect of flow changes: When quickly transitioning from a high (or low) exhaust flowrate
to a low (or high) flowrate condition, an overshoot (or undershoot) in the reported PM may
be experienced.

3. Effect of deseeding: At a long period of operation at zero or low PM levels, the sensor will
sometimes deseed itself.

4. Effect of wiggling sensor cable: Tie the sensor cable down. Don’t let it wiggle. If it
does, noise will appear in the PM and PN signals due to the triboelectric effect.

Usage: pmCAN can be used in engine-out and tailpipe-out installations with diesel and
spark-ignition engines. However in tailpipe-out installations, due to liquid water being in the
exhaust, getting data during start-up can be problematic. Keep in mind that not every start-up
will be affected by liquid water since during some start-ups, water droplets will not hit the
sensor.

Installation: The PM sensor should be mounted perpendicular to the flow of exhaust gases
using the supplied 18mm (thread diameter) x 1.5mm (thread pitch) x 6mm (tall) boss.
Finger-tighten the sensor. Do not use a wrench on the sensor or you may overtighten it and
crack the sensor body. Maximum tightening torque of 1.5 Ibf-ft (2 N-m). Exhaust flow has
to pass by the sensor for it to work. Therefore, do not mount the sensor in a non-straight
piece of pipe where the flow past the sensor may be ambiguous. It is preferential to mount
the sensor vertical with the holes in the bottom pointing straight down. This will help
clear the sensor of water especially with tailpipe-out installations. To avoid the effects of
triboelectric changing (ex. noise in the PM signal), tie down the cabling to the sensor so that
it does not “wave in the wind”.

Exhaust Stratification: PM is not necessarily evenly distributed over the cross-section of
the exhaust. In bends in the exhaust, PM will go straight rather than turn the corner.
Therefore the distribution of PM will be dependent of what is upstream of where the sensor is
located.

Power: The pmCAN kit requires 6 to 32 VDC and consumes 140 mA at 12 VDC.
Grounding is critical. The negative terminal of the power supply should be electrically
connected to the metal that the sensor is mounted in otherwise the system will be
susceptible to seemingly random electrical noise. With tailpipe-out installations, the PM
sensor may be mounted in an extension that is connected to the exhaust system using a small
length of silicon hose. In this case, a braided wire should be run from the extension to the
ground of the vehicle (which for most vehicles is connected to the negative terminal of the




battery). Grounding the case of the pmCAN module to the vehicle can sometimes help as
well. A good noise test is to mount the sensor in an exhaust with no flow (i.e. engine off) and
to collect 0.5 minutes of parameter “IST” (sensor current) data at a sample rate of 10 ms and
an averaging alpha of 1 (i.e. no averaging). This can be easily performed using the supplied
Configuration Tool software and plotted using Excel. IST should have less than £0.5 nA of
noise.

Cleaning: Occasionally the sensor will get fouled with PM. When this occurs, the electrodes
will be shorted and the VHV parameter 1000V+100V potential will be unable to be
maintained. When this occurs, take the sensor out and blow it out with air for about 10
seconds. Sometimes blowing the sensor out won’t clear it so it has to be disassembled and
cleaned. This takes only a few minutes. See Appendix G. Keep in mind that after blowing
out or cleaning the sensor, it will be need to be operated in an engine for a period until it
reseeds.

Indicator Light: On the front of the pmCAN is an indicator light which tells the status of
pmCAN. When the light is solid red (ie. not flashing), the high voltage electrode is turned
off and the sensor can be removed. When the light is solid green, the high voltage electrode
is at 1000 V. The meanings of the light when it is flashing is explained in Table 3. PM, PN,
PMR, and PNR are set to -1 if there is an error.

Calibration: All PM Sensors supplied by ECM are factory-calibrated. This calibration is
stored in a memory chip in the sensor’s connector and is read by the module. Fortunately, the
sensor’s calibration is robust and will not change with age or disassembly/cleaning. Sensors
can be sent back to ECM for a calibration check and repair if they are damaged.

The user may recalibrate or modify the output of the pmCAN in two ways: ZEROing
and SPANing, and using Delta Tables.

ZEROing and SPANing: PM (units: mg/m3) and PN (units: M/cc) can be individually
ZERO’d and SPAN’d. The results of the ZEROs and SPANSs are stored in the memory chip
in the sensor’s connector along with the factory calibration. A ZERO and SPAN can be
cancelled, returning to the sensor to the factory calibration. Always perform a ZERO before
a SPAN.

Delta Tables: The purpose of the Delta Tables is to allow the user to modify the factory
calibration of the pmCAN to match another PM analyzer. With Delta Tables, the user
recurves the calibration of the sensor by different amounts at different PM levels.
Interpolation is performed between the points in the tables. Unlike the ZEROs and SPANS,
the Delta Tables are stored in the pmCAN module and are applied to any sensor attached to
that module. The Delta Tables are entered and programmed into the pmCAN module
using the Configuration Software.



The procedure for the calculation of particulate matter is as follows:

1. IST current is measured and using factory calibration data stored in the memory chip in the
sensor’s connector, the factory particulate density parameters PMR (mg/m3) and PNR
(M/cc) are calculated.

2. The parameters PMR and PNR are then modified by the Delta Tables located in the
module to give PM and PN:

PM = PMR + Delta Table for PM [1]
PN = PNR + Delta Table for PN [2]

The Delta Tables are delivered from the factory full of Os (zeros) so initially, PM = PMR
and PN = PNR.

3. PM and PN are then modified by the ZERO and SPAN processes:

PM (new) = Mm x PM (old) x Bm  [3]
PN (new) = Mn x PN (old) + Bn. [4]

When delivered from the factory, Mm and Mn are set to 1 and Bm and Bn are set to 0.
Thus, PM = PMR + Delta Table for PM and PN = PNR + Delta Table for PN.
When the user performs a ZERO or SPAN, the new M and/or B is stored in the
sensor’s memory chip and used in Equations [3] or [4]. The Configuration Software
is used to perform the ZERO and SPAN procedures and also supports the cancelling
of the user calibration and returning Mm to 1 and Bm to O (or Mn to 1 and Bn to 0).

Calibration is the matching of an instrument to a defined standard. Due to the complexity of
PM, there is no absolute standard and as such, what is called PM often depends on the
scientific principle and application of the instrument being used. This is not to say that
various PM instruments available do not trend and approximate each-other, it is just that they
will not all match each-other to the degree, for example, that various NOx instruments will
match.

ECM’s factory calibration is performed so that users of common laboratory-grade PM
instruments will get results that generally match what they see on their instruments. For
closer matching, the user can deploy the ZEROs and SPANs and Delta Tables features.
Although both ZEROs/SPANSs and Delta Tables can be used at the same time, it is expected
that either one or the other will be used. Consistent with other instrumentation that ECM
manufactures, ZEROs and SPANSs travel with ECM’s factory calibration in the sensor’s
memory chip while Delta Tables are in the modules. The reason for this is that once a user
determines the Delta Table for one sensor, it is likely that all ECM sensors with a factory
calibration will give similar results when connected to the same module. In addition, these
Delta Tables can be downloaded into other pmCAN modules. When determining Delta
Tables, it is important that the user looks at the PMR (or PNR) parameters or the PM (or PN)
parameters with the ZEROs and SPANs cancelled. Otherwise, the Delta Table(s) may be
specific to just that sensor (i.e. the Delta Table(s) should be a modification of the ECM
factory calibration, not a ZERO’d or SPAN’d version).

10



Appendix F: Appendix F is located in the back of this manual and contains examples of
pmCAN in use.
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Configuring a Module

Normally, you will be configuring a module to be used in stand-alone mode. Stand-alone
mode is used when the modules are connected to a CAN bus that goes directly to a data
acquisition or control system. In stand-alone mode, a module’s configuration is performed by
selecting one of the tasks in the “Task” field. When a module is connected to a NOx 5210,
Lambda 5220, EGR 5230, NH3; 5250, or miniSOOT 5260 Analyzer, it must be in EIB mode.
In EIB mode, most of these tasks are performed using the analyzer. Appendix B describes
how to configure a module to operate in one mode or the other.

The following assumes that the module is to be used in stand-alone mode.
available for pmCAN modules are listed in Table 1.

The tasks
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Change Node ID: Allowable range 0x01 to 0x7F (hex). When you assign a Node 1D (NID),
the following CAN IDs cannot be used by any other devices on the bus:
0x00, 0x80 + NID, 0x180 + NID, 0x280 + NID, 0x380 + NID, 0x480 + NID,
0x580 + NID, 0x600 + NID, 0x700 + NID, Ox7E4, OX7ES.

View Module Information: Manufacturer’s Name, Hardware Version, Software Version

Set Broadcast Rate: All activated TPDOs are transmitted every “n” milliseconds. “n” can
be programmed. 5 ms is the minimum. Default: 100 ms.

Set Averaging Filter: Before the data is transmitted by the module (at the broadcast rate), it
can be averaged. The averaging filter is called Alpha, can range from 0.001 to 1, and
is used in the recursive averaging filter:

AvgDatat = Alpha x Datat + (1-Alpha) x AvgDatat-1
where: AvgDatat is the transmitted data at time “t”.
AvgDatat-1 is the previously transmitted data.
Datat is the raw data at time “t”.
This formula is executed every 5 ms regardless of broadcast rate.
Note that if Alpha = 1, there is no averaging and the data taken at time “t” becomes
the average value at time “t” and hence the broadcast value. Default Alpha is 0.010.

Zero PM: User enters displayed PM value (TPDO data) and the actual PM value of the
exhaust (0 or close to 0), and an offset will be applied to shift the calculation to
the actual PM value at this condition. The Zero is stored in the memory chip of the
sensor.

Span PM: User enters displayed PM value (TPDO data) and the actual PM value of the
exhaust. Preferentially Span near the upper PM value to be measured. The Span is
stored in the memory chip of the sensor.

Zero PN: User enters displayed PN value (TPDO data) the actual PN value of the
exhaust (0 or close to 0), and an offset will be applied to shift the calculation to
the actual PN value at this condition. The Zero is stored in the memory chip of the
sensor.

Span PN: User enters displayed PN value (TPDO data) and the actual PN value of the
exhaust. Preferentially Span near the upper PN value to be measured. The Span is
stored in the memory chip of the sensor.

PM/PN Delta Tables: These tables are used to modify the displayed PM and PN numbers to
something other than the factory PMR and PNR calibrations. There are two tables; one
for PM and one for PN. The delta tables are used as follows:

PM = PMR + Delta Table for PM
PN = PNR + Delta Table for PN

As delivered from the factory, both delta tables are full of zeros so PM = PMR and
PN = PNR. Delta tables are stored in the module (not in the sensor memory chip as
the Zeros and Spans are). The Zeros and Spans subsequently act on PM and PN.

Table 1: Task List for pmCAN Modules (continued on next page)
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Toggle High Voltage: Turns the 1000V electrode on and off. To avoid getting shocked by
the 1000V applied to the sensor or possibly damaging the pmCAN’s electronics,
always turn the 1000V off before removing or attaching the sensor from the cable (or
the cable from the module).

Hardware Reset: Equivalent to powering the module down then up again.

Reset TPDOs to Factory Settings: These are the parameters displayed and transmitted.
TPDO stands for Transmit Process Data Object.

Toggle TPDO CAN ID Auto Set: Enable and disable TPDO CAN ID Auto Set.
Default: Enabled.

Export & Import Module Configurations: This simplifies the task of programming several
modules the same way.

Table 1 (continued): Task List for pmCAN Modules
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Selecting What Data is to be Sent (TPDOSs) and Error
Codes

Data sent from pmCAN modules is packaged as TPDOs (Transmit Process Data Object).
Each TPDO contains two pieces of data and each module can send up to four TPDOs. All
selected TPDOs will be sent at the broadcast rate. For example, if the broadcast rate is 5 ms
and four TPDOs were selected to be sent, then eight pieces of data would be transmitted
every 5 ms. To avoid slowing down the effective data rate on the CAN bus, select the
number of TPDOs to be sent and the broadcast rate sparingly. For the case of multiple
modules sending multiple TPDOs on the same CAN bus, the minimum (i.e. fastest) broadcast
rate is given by:

Minimum Broadcast rate (ms) = The total number of TPDOs for all modules x 0.3125

For example, if there are eight modules, each sending two TPDOs, the minimum broadcast
rate is 5 ms.

The data transmitted is selected in the “Data” area of the Configuration Tool. Activate the
number of TPDOs to be used by clicking in its box to put in a check mark. Select the data
contained in each TPDO using the pull-down windows. The list of available parameters for
the pmCAN module is given in Table 2.

Parameters PM and PN should be used for PM mass and number densities (not PMR and
PNR). This is because the Zeros, Spans, and Delta Tables act on PM and PN, not PMR and
PNR.
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Name Parameter Description

CIR 16 bit A/D Calibration (Bits)

C2R 16 bit A/D Calibration (Bits)

ERCD ECM CANOpen Error Code (unsigned integer)

ERFL Module Error Flags (unsigned long format)

ILK Sensor Leakage Current (0-40 pA)

IST Sensor Current (0-1000 nA)

ITP Transformer Primary Current (0-225 mA)

ITPC Calculated Transformer Primary Current (0-225 mA)

PM Delta Table Modified Particulate Matter Mass Density (mg/m3),
PM = PMR + Delta Table for PM. Use this parameter for PM.

PMR Factory-Calibration Particulate Matter Mass Density (mg/m3)

PN Delta Table Modified Particulate Matter Number Density (M/cc),
PN = PNR + Delta Table for PN. Use this parameter for PN.

PNR Factory-Calibration Particulate Matter Number Density (M/cc)

TPCB Temperature of the Module Circuit Board (deg C)

VHV Actual High Voltage Electrode Voltage (0-2000 V)

VHVC High Voltage Electrode Voltage Command (0-2000 V)

VILK Voltage output of Sensor Leakage Current Circuit (0-5000 mV)

VIST Current Measurement Voltage (0-5000 mV)

VSW Supply Voltage at pmCAN Module (0-40 V)
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ECM Error Code
(hex)

LED Action
(R=red, G=green)

Description of Error

0x00 G On All OK

0x01 Flash G @ 10hz Start-Up

0x02 G,G&R,R @ 2s Power ON Reset/Init Hardware

0x13 R On High Voltage Off

0x14 Flash R 1x @ 2s No Sensor Detected

0x15 Flash R 1x @ 2s Water in Sensor

0x41 Flash R 4x @ 2s ITP Too High

0x42 Flash R 4x @ 2s ITP Too Low

0x52 Flash R 5x @ 2s VHVC - VHV > 100V for 5s

0x61 Flash R 6x @ 2s ILK Fault

0x62 Flash R 6x @ 2s IST Fault

OxAl Invalid Software State

0xB1 CAN Overrun

0xB2 CAN Passive Mode

0xB3 CAN Heartbeat Error

0xB4 CAN Recover Bus Off

0xB5 CAN Tx CAN ID Collision

0xB6 Serial Overrun

0xB7 CAN Overrun LSS

0xB8 CAN Overrun SDO

0xB9 CAN Overrun Rx

0xBA CAN Overrun ECT5

OxFF G&R On Module Powering Down Within 500ms
Table 3: pmCAN Error Codes List

Notes:

1. “G,G&R,R @ 2s” means Green LED Flashes, then Red and Green LEDs flash together,
then just Red LED. This pattern repeats every 2 seconds.

2. “Flash R 4x @ 2s” means Red LED Flashes 4x and this is repeated every 2 seconds.

3. If an error from 0x00 to 0x62 is present, PM, PN, PMR, and PNR are set to -1.
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Producing a .dbc File

A .dbc file describes to the device receiving data from one or more CAN modules what is in
the data packages. For each module, the packages will contain data for the parameters
selected in the activated TPDOs and an error code. The Configuration Tool has a tool called
“Generate .dbc...” that will generate a .dbc file for all the CAN modules on a CAN bus.
Make sure that each module is configured as desired and that all modules are on the bus
before the “Generate .dbc...” button is pushed. Data package information from all the
modules is stored in the one .dbc file produced.

Programs importing the .dbc file and applying it to the CAN data transmitted by the modules
will see data, etc identified as follows:

Data: name_nid[units]
where: name = parameter name. See Table 2.
nid = node id of module in hex
units = units of parameter
for example: PM_0X01[%] which is the PM parameter from module with nid 0X01
Error code: ECM_Error_Code nid

where nid = node id of module in hex
error code is in hex and given in Table 3

for example: ECM_Error_Code_0x13
Auxiliary: ECM_Auxiliary _time[sec]
where: time = decrementing countdown to module activation in hex

for example: ECM_Auxiliary_0X12[sec]
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Using the dashCAN™* Display

dashCAN~* (i.e. all dashCANS) is a small (105 mm x 63 mm x 63 mm for dashCAN and
dashCAN2, or 105 mm x 63 mm x 165 mm for dashCAN+) display for CAN networks
containing ECM CAN modules. dashCAN has two displays and no analog outputs.
dashCAN2 has two displays and two programmable analog outputs. dashCAN+ has two
displays and six programmable analog outputs. dashCAN* comes with a two meter cable
and a “T” (P/N 09-05). Simply attach dashCAN* to the CAN bus and parameters from one
or two ECM CAN modules can be displayed and converted to analog outputs (dashCAN2 or
dashCAN+ only). The top display and half the analog outputs can be assigned to one module
and the bottom display and the other half of the analog outputs can be assigned to the same or
another module. Multiple dashCAN* displays can be attached to the CAN bus.

dashCAN* has two modes of operation: RUN (when measurements are displayed) and SYS
(where dashCAN™ is set-up). The SYS key toggles between the modes.

While in RUN mode:

i. If the T button is pressed, the displays will show the serial numbers of the modules
assigned to the displays.

ii. If the { button is pressed, the displays will show the parameter names assigned to the
displays. See Table 2.

iii. If the ENT button is pressed, the displays will show the units of the parameters.
“PCTG” is %. “dIM” means dimensionless.

In RUN mode, four things other than data can be displayed:

1. “ERR” and “##H#” where “####” 1s an error code. See Table 3.

ii. “....” which means that a module has not been assigned to that display.

1. “---- which means that dashCAN* has an internal problem.

v. “XXXX” which means that dashCAN* is not receiving any data from the module

assigned to that display.

dashCAN
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When first entering SYS mode, either “MOd” will be on the top display or “LOCK” will be
on the bottom display. If “MOd” is displayed, the T and ¥ keys will roll through the setup
options (see Table 4). First the options for the module assigned to the top display are shown
on the top display, followed by identical options for the module assigned to the bottom
display, ending with the global CONF (Configuration) setup. Pressing the ENT key will
select the displayed setup option and allow its programming.

If “LOCK” is displayed, the dashCAN* has been locked and its setup cannot be changed until
it is unlocked. Appendix E describes how to LOCK and unlock dashCAN*.

Setup Option Level 1 Function
MOd Select module s/n to be assigned to the display. Default is NONE.
RATE Set parameter averaging rate. Range 0.001 to 1.000
Default is 1.000. 1.000 means no averaging.
AOUT (dashCAN+ only)

Al Program analog output 1 from module assigned to top display
A2 Program analog output 2 from module assigned to top display
A3 Program analog output 3 from module assigned to top display
A4 Program analog output 4 from module assigned to bottom display
A5 Program analog output 5 from module assigned to bottom display
A6 Program analog output 6 from module assigned to bottom display

AOUT (dashCANZ2 only)
Al Program analog output 1 from module assigned to top display
A2 Program analog output 2 from module assigned to bottom display

dISP Select parameter. Note: Parameters available are those
contained in TPDOs programmed to be transmitted from
the module (programmed using the Configuration Tool).

CONF LEdS dashCAN+ only. Set display intensity. Default is 3333.
dashCAN and dashCANZ2 have a knob for display intensity.

1V4V dashCAN2 and dashCAN+ only. Command 1V and 4V outputs.

LOCK Lock and Unlock Display for Programming

MOd, RATE, AOUT, and dISP appear on the top display for the module assigned to the top
display and then on the bottom display for the module assigned to the bottom display. CONF
just appears on the bottom display and is for global dashCAN* setup. All entries must be
followed by pressing the ENT key.

Table 4: Menu Tree for dashCAN~*
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MOd (Module) Setup Option

In MOd setup, the serial number of the module assigned to the top or bottom display is
entered. The serial number is written on a label on the module. The module assigned to the
top display will be assigned the first half of the analog outputs. The module assigned to the
bottom display will be assigned to the second half of the analog outputs. The same module
can be assigned to both displays or different modules can be assigned to each display.

After entering MOd (i.e. press ENT when “MOd” is displayed), the serial numbers of the
available modules will be displayed. Select using T and  followed by the ENT key.

RATE Setup Option

Data is transmitted from modules at the broadcast rate and the averaging that was
programmed using the Configuration Tool. This transmitted data can then be further
averaged before being displayed on the displays. Separate averaging can be programmed for
the top display and the bottom display. RATE does not affect the analog outputs.

The averaging (o) is programmed with values from 0.001 (heavy averaging) to 1.000 (no
averaging). The default is 1.000. The averaging is performed as follows:

DisplayedValue; = o x Parameter; + (1 — a) x DisplayedValue;
where:

DisplayedValue; = the new displayed averaged value

a = The user-programmable averaging.
Range: 0.001 (heavy averaging) to 1.000 (no averaging).

Parameter; = the latest value transmitted by the module

DisplayedValue.; = the previous displayed averaged value

AOUT (Analog Outputs) Setup Option (dashCAN+ and dashCAN2 only)

The dashCAN2 display head has two 0 to 5V programmable analog outputs. The dashCAN+
display head has six 0 to 5V programmable analog outputs. The analog outputs are updated
at the module Broadcast Rate (see Table 1). This can be as fast as every 5 ms. Keep in mind
that the data may be averaged (see Set Averaging Filters in Table 1) before being broadcast
by the module.

Parameter information from the module assigned to the top display (see MQOd) can be sent to
analog output 1 (for dashCANZ2) or 1, 2, and 3 (for dashCAN+). Parameter information from
the module assigned to the bottom display can be sent to analog output 2 (for dashCAN2) or
4, 5, and 6 (for dashCAN+). Only parameters selected as active TPDOs for that module
(using the Configuration Tool) can be output.
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Here is an example of setting analog output 2 for a dashCAN+ (i.e. A2):

Press the SYS key so that “MOd” appears on the top display.
Press the 4 key until “AOUT” is on the top display. Then press the ENT key.
Press the 4 key until “A2” (analog output 2) is on the display. Then press the ENT

key.

Press the T and 4 key until the parameter (see Table 2) that will drive A2 is displayed.

Then press the ENT key.

When 0V is displayed, press ENT. Using the T, ¥, and ENT keys, set the parameter

value that you want to result in an analog output voltage of OV on analog output 2.

The first time you do this, it may be a little tricky. You are setting one digit at a time

and for some numbers, the display will shift to the left so you can set the right-most

digits. If you get into trouble when programming, press the SYS key twice to exit and

re-enter setup to try again.

6. When 5V is displayed, press ENT. Using the T, |, and ENT keys, set the parameter
value that you want to result in an analog output voltage of 5V on analog output 2.

7. When “AOUT” is displayed, press SYS to return to RUN mode.

o ~ whe

If in the above example analog output 4 was being programmed, AOUT, A4, 0V, 5V, and
your entries would be shown on the bottom display.

dISP (Display) Setup Option

The dashCAN~* display head has two displays, the top display and the bottom display.

In dISP setup, a parameter from the module assigned to the display (see MOd) can be shown
on the display. Only parameters selected as active TBDOs for that module (using the
Configuration Tool) can be displayed.

Here is an example of setting the parameter to be displayed on the top display:

1. Press the SYS key so that “MOd” is displayed.

2. Press the 4 key until “dISP” is on the top display. Then press the ENT key.

3. Press the T and | key until desired parameter name is displayed. See Table 2. Then
press the ENT key.

4. Press SYS to return to RUN mode.

CONF (Configure) Setup Option (LEdS, 1V4V, LOCK)

CONF setup appears at the end of the setup list on the bottom display. To enter CONF, press
the SYS key so that “MOd” appears on the top display, press the { key until “CONF” appears
on the bottom display, and then press the ENT key. CONF is for global dashCAN* setup.

¢ LEdS (dashCAN+ only)

The display intensity is programmable. Press the ENT key when “LEdS” appears on the
bottom display, press the T or { keys until the display intensity is suitable, press ENT, and
press SYS to return to RUN mode.
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¢ 1V4V (dashCAN2 and dashCAN+ only)

“1V4V” commands the analog outputs to go to 1V then 4V. This is used to verify that the
data acquisition system reading the analog outputs is correctly reading them.

¢ LOCK

“LOCK” locks the MOd, RATE, AOUT, dISP, and LEdS setup. This stops unauthorized
modification of the display. Refer to Appendix E for more information.

23



Appendix A: pmCAN Kit Contents
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The pmCAN Kit consists of:

N

'—‘“3.00.\‘.@9".#.‘*’

N

o

Description P/N
pmCAN Control Module 02-15
PM Sensor (tailpipe application) or 06-10T
PM Sensor (diesel engine-out application) 06-10E
PM Sensor Cable, (2m) 10-48
Flexi-Eurofast Cable, (0.3m) 09-04
Eurofast “T” 09-05
Eurofast Terminating Resistor 09-06
Eurofast 12mm Cable, (2m) 09-02
DC Power Cable, DB9F, Banana 11-02
Sensor Boss & Plug, SS, (18mm x 1.5mm) 12-03
0 Manuals and Configuration Software CD 13-01

Optional Components:

AC/DC Power Supply, Universal 24VDC @ 4.2A 04-01
(requires P/N 11-17 Deutsch DTM3M to DB9F Cable)
Kvaser Leaf Light CAN Adapter 13-02
PM Sensor Cable (3m) 10-49
Note: pmCAN has been approved for use with no

sensor cable, a 2m sensor cable, a 3m sensor

cable, and any combination of cable lengths

up to 6m. Tie the sensor cable(s) down since

cable wiggling will generate noise in the PM

and PN signals due to the triboelectric effect.
PM Sensor Cleaning Kit 14-15
Spare PM Sensor Gasket 12-62

PR RPRRPRRPRRPRRRERR

Quantity
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Appendix B: Module Stand-Alone Mode and EIB Mode

CAN data from CAN modules (ex. pmCAN, NH3;CAN, NOxCAN, LambdaCAN) can either
be taken directly from the modules themselves or from the CAN port of display heads
connected to the modules. When data is taken directly from one or more modules, each
module must in Stand-Alone mode. When data is taken from one or more display heads of a
NOx 5210, Lambda 5220, EGR 5230, NH3 5250, or miniSOOT 5260 analyzer, each module
must be in EIB mode.

Therefore, the module must be properly configured in Stand-Alone mode or EIB mode
depending on how it will be used. When CAN modules are sold alone, they are delivered in
Stand-Alone mode. When CAN modules are sold as part of a NOx 5210, Lambda 5220,
EGR 5230, NH3; 5250, or miniSOOT 5260 analyzer, they are delivered in EIB mode.

To convert from one mode to the other requires the installation (to set to Stand-Alone) or
removal (to set to EIB) of a jumper inside the module and software reprogramming of the
module using the Configuration Tool.

& To convert a module from EIB to Stand-Alone Mode

1. Using a 19mm socket, remove the nut and washer from the eurofast connector.
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2. Using 5/64” (or 2mm) hex wrench, remove the 4 screws on the front of the module.

3. Slide the PCB out. Put the jumper on both pins for Stand-Alone Mode.

Jumper
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4. Make sure the O-ring is on the eurofast connector.

- =) of* "ﬁ—\ >

f R 3] 2o o™

5. Slide the PCB back into the enclosure and reattach the four screws on the front of the
module.

6. Put the washer and nut on the eurofast connector and tighten.

7. Connect the module to a power supply and a PC (via a CAN communication adapter)
using the cabling shown. A sensor does not have to be connected to the module.
Note that only one module is connected and a display head is not involved.

P/N 11-02, DC Power Cable,
DBYF, Banana Plugs (shown), or
P/N 11-01, DC Power Cable,
DB9F, Spades

To CAN adapter
— Termination Resistor on PC

N

To power

Figure Al: Module prepared for Reprogramming



8. Start the Configuration Tool (software). Click on the “Module” tab.
Select the CAN adapter being used. Then start the communication.

= ECM Configuration Tool v4.48.06

Modules IAnaIyzers] Firmware Upgladel

Configuration Tool

Toggle Wamings [Mow: OFff]

CAN Adapter: [Kvaser < ||LeafLightHS 1(Ch1) < ||250Keps  ~| ¥ Exclusive _STOP | [l
 Configuration Tools
NID [Device Type, S/N] ECM Bus Load

Module: | 0428 [pmCaN, 2]

| | [1% 26 tps

Task: ]View Module Information

LI Total Bus Load

Log Data [0ff] |

Export .dbc ] User Manuals |
Manual Comm. I Set CaN Baud |

[1%2, 29 fps

Hardware Version = 1.00|
Software Version =1.10

Product Code = 20 [0x14)
Revision Code =1 (0x01)

Sensor S/N

Data for Node ID: 028  TPDO: Data transmitted by module

- Set Module Mode

used with one module on the bus.

Calc. %202 in &ir ]

Setup miniF‘EMS] Exit Free-Run |

EE | Standdlone |

Mote: This function can only be

TPDO1 ¥ TPDO2 W TPDO3 ¥ TPDO4 W
[0001000076) [py ] [lsT ] [wisT  ~| [vhy |
Emor  Aux

0 3 [00197312 n& 0049328 mv  [1000 v
[0x00 " [0x00 ! mon3 | ! ¥ !
o2 CoNstatelPN @] ko] foee of P o]
[ j0x05 |0 Mcec  |0693551 uwA 328 mh o [322 mé,

www.ecm-co.com  408-734-3433 « | os Altos, CA, USA

9. Click on the “Stand-Alone” button. Wait for the “Done” Message.

Stop communication and exit program. The module is in Stand-Alone Mode.

& To convert a module from Stand-Alone Mode to EIB Mode

1. Connect the module to the Configuration Tool and click on the “EIB” button.

2. Open the module and put the jJumper on just one pin (either one).

3. Close up the module.
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Appendix C: Setting Up ETAS INCA for ECM Modules

Hardware Setup: Using ETAS ES591.1

Connect the power port to a power source between 6V and 32V.

Connect the Ethernet port directly to the Ethernet port on your PC. This port does not
use an internet/intranet connection like a router.

Connect either the CAN1 or CAN2 port to a CAN network (i.e. ECM modules or
display heads).

Software Setup: Using ETAS INCA V5.4.1, Hotfix 22, GM Install

30

1. Double click the INCA V5.4 icon to open the software.

2. Create a new Database. In the Database menu, select New. Give your database a

name (i.e. a folder name). In INCA, a Database means the current working directory.
Each project is created in a unique directory. When INCA is opened, it will default to
the last Database that was used.

. Add a new Workspace. Right click on the “DEFAULT” folder icon, select Add >

Workspace. You can rename it to whatever you want.

- INCA V5.4.1/22

Database Edit Yiew Options Utilities 7
D= E Xl - 0 HRERE D Y

1 Items

Add 3 Add top Folder
Add Folder Insert
Delete Delete Experiment Chrl+T
ECU-Project (aZ()... Crl+P
Copy Chrl+C COM-Configuration Alt+C
Measure-Catalog. ..
Rename Fz ECU Documentation, ..
Can-DE...
List of CAN Messages
Import Ctrb+1 Read CAN Message Log File...
Expork Chrl+E
Write: 3

Convert Experiment 3

4. Add a new dbc file for your project. Right click on the workspace you created in

step 3, select Add > Can-DB. Browse to your dbc file and click open. In this
example, we are using a file named test8mod.dbc. An INCA log window will pop up.
You can ignore this.




3 INCA V5.4.1/22

Database Edit  Wiew Options Utilities Experiment Project Device 7

DSHE »BROEX E-% & EREH D8 Y
L ttoms % INCA V5.4.1/22*
[l {ZdDEFALLT Database Edit Yiew Options  Utilities
T S 1o o = 3 g
A £ . 2
Add Folder Insett D L= E ':"% x "& |
Workspace Chriw 1 Items
Delete Delete Experiment Chrl+T —
E”t E:r::z ECU-Project (A2D. . Crlep =l {ADEFAULT
=Py ! CDM-Configuration Al+C — nod
- L4
Measure Cataloq.... gL": Workspace
Rename Fz ECU Documentation, .,
Edit Return
| List of CAN Messages
Lmport Cerk Read CAN Message Log File. ..
Export Chrl+E
Wrike 3
Convert Experiment »

5. Configure the hardware. Click on the icon for the workspace you created in step 3.
Open the Hardware Configuration icon under the section text “6. Hardware”. A
hardware configuration window will open.

IHCA

5 INCA V5.4,1/22* (=1[e3

Database Edit  ‘iew Options Utlities Experiment  Project Device 7
DEE & B0 X ## % %8 iH %I 2 & @R

1 Ikems 4 Expetiment
=) I DEFALLT Al E s X

I: B ct5mod |

S Project/device

u

=

[ Hardware/

Workspace L

3 Item comment Caonfigure hardware

(4/1/2006 3:27:24 PM 528 55

|

Filter: none | DB: <test: User: <MainUser >
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6. Select the hardware. In the hardware configuration window, right click the “HWK
Workspace” listed under the section text “1. Hardware Devices”, and select Insert.
Select the ETAS device you wish to use. In this example, we are using an ETAS
ES591.1. Expand the selection tree by clicking the “+” next to the hardware device
model. Expand the CAN selection and select CAN-Monitoring. Click OK.

. Hardware: >Workspace= Experiment: >Default<

File Hardware Device Channels Yiew 7

HOT B | e o
3E Add| handware device

1 Hardware devices
Hwl Wiorks]
orkspace Select the new modules you want to add to
the hardware configuration. —
Avvailable HY devices Cancel |

5 R ES600/ESSI0/ESSS1 Multiglcity

—E= T can {Inactive)
CAN-Monitaring; Il— :-I

= amLan —

2 can-output

fucp

cce W

= kwipz000

E=Fups

—E Ek-Line...

EheTrC

LR o T T

|2

<

7. Associate the dbc. When you clicked OK in the last step, another window will pop
up that will allow you to select a dbc that you have added to your workspace from
step 4. Expand the selection tree, select your dbc file, and click OK.

—./Hardware: >Workspace< Experiment: >Default<

File Hardware Device Channels Yiew 7

MO E A8 O e

Select project and working data for CAN-Monitoring:1

1 Hardware devices

HWE Workspace i
I?_ 555991555904’5%591’1 1 Items add ||| 41nfo —
SN: Mok assignes — = — QK
L% CAN:L =] {ZDEFALLT ~ ;l -
@CAN—Monitoring:l L =, bestEmod -
Cancel | sty e

€

Fnent F

|Can_DB... - kestamod

3 Ikem comment
(4/1/2005 3:36:10 PM 937 63)




8.

Initialize hardware. The hardware is currently stopped, as indicated by the red stop
sign icon next to the selected hardware. You must initialize it before you can use it to
collect data. Click on the Initialize Hardware button on the upper tool bar and wait
for the hardware to complete its initialization. Another window will pop up to
confirm the device to connect to. Click OK.

—'IHardware: >Workspace= Experiment: =D

Systems

INCA Hardware Configuration Detected Hardware e} Connected ]

i’ Connect devices...

File Hardware Device Channels Wiew ?
#o = J4dE B
1 Hard .

MOTRSpECE

ES690/ESS90/ESS21:1
SM: Mot assigned

I— CAM:

Cr-Manitaring: 1

Filter

Ho:

@ all connect

Type:
ESEO0[ESSO0/ESSI1: L
SN: Not assigned SM: 120411

o

Info | .
stirterfaceType System type

ted

9.

—'Hardware: >Workspace= Experiment: >Default<

Open an Experiment Environment. Click on the Experiment Environment button
on the upper tool bar to open an Experiment Environment. The Experiment
Environment is where you can setup the monitoring of the CAN bus. By default, the
Experiment Environment will be blank. You must select the variables from the dbc
file that you wish to monitor. Click on the Select Variables icon in the left hand tool

bar of the Experiment Environment.

Expetiment View Yariables Mea:

File Hardware Device Channels Wew ¥

#o = 1JME B

1 Hardware devices ,{fxperiment environmenk CtrI+F5|
HWE Workspace

iE! ESB90/ESSI0/ESSIL:1

Hor U R OW D

v,
L CAM:L Select variables.. . Shift+F4

€ Can-Manitoring: 1

-
a
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10. Select and Configure Variables. Select the variables that you wish to monitor in the
Experiment Environment. These variables names are based on the data found in the
dbc file. Click Configure.

“a; Select variables <Measure variables >

Filtet ‘“ariables Selected 7

1 Devices E 3 Yariables 4 Selected already used
= Be O can-Monitaring:1 ~| | [*F0 arr_ox0r {TPDOZ_0x01-F AFR_x01
—— Bz O Emergency_0x01 &0 Canopen_Frror_Code_0x01  {Emergency_0x01-F- CANopen_Error_Code_0x01
—— B2 O Emergency_0x02 *C0 CANopen_Error_Reg_0x01  {Emergency_0x01-fr CANopen_Error_Reg_0x01
— B0 Emergency_0x03 *T0 CANopenState_0x01 {Heartbeat_0x01-f} CANopenState_0x01
—— B2 0 Emergency_0x10 €0 ECM_awsliary_0x01  {Emergency_0x01-F- ECM_Auxiliary_0x01
—— £20 Emergency_nxzo *£'0 ECM_Error_Code_0x01 {Emergency_0xO1-f} ECM_Errar_Code_0x01
— Bg O Emergency_Ox21 B0 FAR_Ox0L  {TPDOZ_Ox01-f} FAR_0x01
—— P20 Emergency_0x22 TEO LAM_ml  {TPDO1_Ox01-f} LAM_0x01
—— £20 Emergency_nxz3 Y0 0z_ox01 {TRDOL_0x0i-f} 02_0x01
— Eg O Heartbeat_0x01
— Eg O  Heartbeat_0x02
— Eg O Heartbeat_0x03
— Eg O Heartbeat_0x10
— Eg O  Heartbeat_0x20
— B2 O Heartbeat 0xz1 ™

Mo raster pre-selection possible!

Configure | Use defaults | Cancel

11. Another window will pop up to configure each selected variable. You can configure,
for each variable, whether to record or simply display the data, how the data will be
displayed (graphs, charts, gauges, numeric, etc.). When complete, click OK. We
have left all configurations at default for this example.

i Configure Selected Yariables |zl@@

Components  Filker  Parameters

2 Parameters

Parameter I
Mame Stabe dT =7 ‘window Display type Device
AFR_0x01 Dispfrac Layer_1>»<Meas.> Murn ZAM-Monitoring: 1
CAMopen_Error_Code Dispfrec Layer_1=x<Meas. = Murn ZAM-Monitoring: 1
CAMopen_Error_Req. Dispfrec Layer_1=x<Meas.= Mum CAN-Monitoring: 1
CAMopenState_0x01 Dispfrec Layer_1=x<Meas.= Mum CAN-Monitoring: 1
ECM_Auxiliary_0x01  Dispfrec Layer_1=»<Meas.= Mum CAN-Monitoring: 1
ECM_Errar_tCode_0x( Disp/rec Layer_1=»<Meas.= Mum CAN-Monitoring: 1
FAR_Ox01 Dispfrec Layer_1=»<Meas. = Mum CAN-Monitoring: 1
LaM_0x01 Dispfrec Layer_1=»<Meas. = Mum CAN-Monitoring: 1
0Z_0x01 Disp/rec .Layer_1=><Meas.> ’—L| CAN-Monitoring: 1

Active Component: <Experiment:=  |Active Filter: <all Types= |Active Parameter: <OZ_0x01=

QK Cancel

12. A new sub-window will be added to the Experiment Environment. You do not need
to select all the variables you want to monitor all at once. You can click on the Select
Variables icon again at a later time to add more variables. Each set of variables you
add will be placed in a new sub-window unless it is configured to join an existing
sub-window. In this example, we have created a sub-window for each of the eight
modules in the dbc file.



Experiment: >NewExp= Hardware: >Workspace<

Experiment Yiew Varjables Measurement Hardware Dataset Components tindow 2

D | re—" B[] 2] Measure window [+ 8| |8 Measure windo =
z 02_0x01 [ - 126 Q2R _0x10 I - [ 126] O2_0x22 ] - 13%]
— | AFR_Dn01 I -In CAMopen_Error_Reg_0x10 | [thex) | AFR_Dx22 ] -lo
g CAMopen_Error_Code_0x01 H -H[hex] CANDpen_Errcr_Code_DxWD[l -ﬂ[hex] CANDpen_Errcr_Code_Dx22|l —H[hex]
; CANopen_Error_Reg_0x01 H = H [hex] CAMNopenState_0x10 [l -|| [hex] CAMopen_Error_Reg_0x22 || —H [hex]
. | SANorenstate o1 | -lihed | ECM_Awdliary_0x10 [ -|ihed | CANopenState_0xz2 I - thex
| Eoh Adliany Dl | “|ihed | ECM Error_Code_0x10 [ Jihed | ECM_Ausdliary_0x22 I - thex
3: ECM_Error_Code_ 0w | Jiheq fiP1_oxi0 [ |ima] | ECM Error_Cods_0x22 I - thex
mm | FAR_0:01 | o P2 010 [ [ wal FAR_ =22 I o
o llLani o [ o WO _0x10 I Jippm) [fLar mx22 I B [
y L do | %] Measure windo =] =] Measure window [3 =)
e | O2_0x02 I - 12%] 0z_0x20 I - 12] AFR_0x23 I -|n
Il | AFR D2 | -To AFR_ 0520 [ -To CARNopen_Error_Code_0x23 | -|thex
2] CAMNopen_Error_Code_0x02 H fﬂ[hex] CAMopen_Error_Code_0x20 [l fﬂ[hex] CAMopen_Error_Reg_0x23 |] ﬂ[hex]
g CAMNopen_Error_Reg_0x02 H = H [hex] CAMopen_Error_Reg_0x20 [l = H [hex] CAMNopenState_[x23 |] || [hex]
g | SAnepenSiate 0x02 | “Jihexd | CANopenState_0x20 [ Jihex) | ECM Ausiliary_0x23 [ | thex
7 | ECM_Awidliary_0x02 | Jiheq | ECM Ausiliary_0x20 [ ~|lhex) | ECM Error_Code 0x23 [ | ihe
ECM_Error_Code_0x12 [ -|ihexg | ECM_Errer_Ceds_0x20 [ e | FAR_0x23 [ o
FAR_0x02 I -Io FAR_0x20 I -Io LAM_0x23 I -Io
LAK_ 02 I -1n [N[Car oo I -1n 02_0x23 I BES
= asure do O | Measure dow [6 m|
Q2R_0x03 | - [z] 02_0x21 - [24]

CaMeopen_Error_Cede_0x03 |I - [hex] AFR_Ox21
- | [hex] CAMopen_Error_Code_0x21
- | [hex] CAMopen_Error_Reg_0x21

[ l [
[ l [
[ l [
[ I [
= H [hex] CAMNopenState_0x21 || —H [hex]
[ l [
[ l [
[ | [
[ | [

CAMNopen_Error_Reg_0x03 ||
CANopenState_0=03
ECKM_Avxlians_0x03

l

I
ECM_Error_Gode_0x03 II - | [hex] ECM_Auxiliary_0x21 - | [hex]
1P1_0x03 || - [ ECM Error_Code_0x21 - [hex]
1P2_0x03 ] - uA) FAR_ =21 -n
N 0x03 I - [pprr] [[LAM 0x21 -n

) |Measurement stopped Maz. buffer level: 0%

13. Start CAN monitoring. Right now there is no data displayed. That is because the
CAN monitoring is stopped. To begin CAN monitoring, click on the Start
Visualization icon (blue triangle) on the left hand tool bar. To stop CAN monitoring,
click the Stop Measuring icon (black square) on the left hand tool bar. To begin
recording the data, click on the Start Recording icon (red circle) on the left hand tool
bar.

e | 02 Ox02

I | AFR_0x0Z
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Appendix D: Setting Up ATI Vision for ECM Modules

NOTE: While shown here for a single LambdaCAN module, the same procedure applies for any of
ECM’s CAN-based devices as well as for multiple modules simultaneously connected on the same bus.

Introduction

Connecting ECM LambdaCAN hardware to ATI VISION software is simple and does not require any
third-party software interface. Using the ECM Configuration Tool software to produce a .dbc database
file, and the ATI VISION CANMonitor interface, any available hardware CAN interface can be used to
read LambdaCAN data.

Hardware Setup

A typical hardware configuration is shown in Figure 1. In this example, a Kvaser Leaf Light CAN-USB
adapter is used. Other supported adapters have a similar procedure. Connect the DB9 CAN connector
of the LambdaCAN to the PC to CAN adapter. Supply 11-28V DC (5A min. supply) to the
LambdaCAN.

PC with PCto CAN DB9 Connector
ATI VISION Adapter

and ECM UsSB ( .
Configuration L Kvaser Leaf Light

Tool L
Termination
/ Resistor
—1
DC Power Supply
11-28V
|
[ ]
Software

e ATIVISION 3.6.2
e ECM Configuration Tool v4.13

Figure 1: Equipment Schematic Layout
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Creating a .dbc File

The ECM Configuration Tool is used to create a .dbc database file for describing the CAN
messages broadcast from the LambdaCAN. All ECM products with a CAN interface use the
CANopen protocol at 500kHz by default. To generate a .dbc file using ECM Configuration
Tool:

1. Connect hardware as shown in Figure 1. Ensure LambdaCAN bi-color LED indicator
near sensor connector is visible (green during normal operation, flashing red without
sensor attached).

2. Run ECM Configuration Tool software, and select the Modules tab (or the Analyzers

tab if connecting to 5200 series analyzers).

Select CAN adapter from drop down menus as shown in Figure 2, and click START.

4. After LambdaCAN module(s) have initialized, select desired parameters to transmit
from the TPDO drop down menus for each module.

5. Click Generate .dbc, and save this file in a location such as the VISION Projects
folder.

6. Click STOP to end CAN connection.

w

NOTE: Whenever TPDO’s are modified, a new .dbc file must be created.

ECM Configuration Tool || ECM Configuration Tool

Madules I Analyzers I Firrnware: Upgrade] Toggle ‘W arnings [Naw: OFf] Modules ] Analyzers] Firmware Upgrade] Toggle Warnings [Mov: OFf]

CAN Adapter, [Kaser ~|[Lesflighhs aichn] | [S00KEpsletd] =] [iETART] Status: [l CAM Adapter. |Kvaser ~|[Cestlignt s 0(Chn) | [500Kbpsistd] =] STOP | Status: [l

Configuration T Configuration Tools
MID § Prod# Rev.# Serall ECH Bus Load Log Data [0 | MID  Prod# Rev.# Serall ECHM Bus Lo Log Data [0 |

Module: | l | | o 0tps ‘enemte = Ui Module: [0¢10 0w02  OW0E  0x034D | | [18% 806 fps = User Mo

Task: | / = Total Bus Load hanual Comrn. | Set CAN Baud Taskc[Change Nods D =l Total Bus Load Manual Comm. | Set CAN Baud

[0 0fps t oo, %02 in i w [19% 824 fos Calo. %02 n Al

Set
Set Module Mode Frange: U0 - Ox7F Set Module Mode
EIB | Stand-Alone | ECM recommends labeling the module with the new MID. EIB | Stand-flone

Mote: This function can only be The following CAN 105 are used for each module: Mote: This function can only be
uged with one module on the bus. = used with one module on the bus

Data for Mode 1D: NAA Data for Nade |D: 0«10 TPDO: Data transmitted by module
Sensor S/N TPOO1 [ TPDOZ [ TPDOZ [ TPDO4 [ Sensor 5/N TFDO1 v TFDOZ v TFDOZ v TFDO4 v
I I s N I B G v <] [ <] [poa <] [ o]

Eno_ Aw |5 [0 o [0 Co. e 325409 01347  kPa [6B5 ohms

0:00  |0x00
Enar P CO State ‘ j | j | j | j C0O State |02 j ‘FAH j ‘IP]X j ‘VHCM j

[ o o o n/a  |0x05  [20.954 % |0.307305 [eomis  mA g Y

WWw.ecm-co.com « 408-734-3433 = Los Altos, CA, USA = {c) 2011 Www.ecm-co.com « 408-734-3433 = Los Altos, CA, USA = {c) 2011

Figure 2: ECM Configuration Tool
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Setup CANMonitor using ATI VISION

ATI VISION CANMonitor provides a method of reading general purpose information from any
available CAN channel. The .dbc file generated by the ECM Configuration Tool is used to describe the
format of the information available to VVISION. To setup a CANMonitor in ATI VISION:

1. Run ATI VISION and open an existing Project File or create a new one by clicking File >
New -> Project File. In this example the Project has been named CANMonitorProject.

File View Tools Window Help - -
(& Project File
] .. (B ®[Strategy File
= Open... Cirl+O .EEMX configuration File

ﬁ Calibration File
[ kaM Data File

54 Import and Export... Ctrl+Q

Recent Projects [Escreen File

Recent Screens ﬂASCII Text File
@RTF Document File

Recent Files

Exit

Description
IVV'ISION project settings and device configuration

E e SR )

Device Tools Window Help ~#R5-232 Serial Port

= & UsB Port
[S]Add Device.. F5 | Shreoppor
= Rermove LF POMCIA Port
Brciport
=3 Properties =3 SPvirtual CAN Channels
S2PC Based CAN Channels
Context Menu ] specifications

ile Edit View Project

Fodd s

Description
IVPC Based CAN Channels on this computer.
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3. Add a physical hardware device by clicking Device = Add Device, and select Kvaser CAN
Channel.

i H D
Select Device Type -

H@ File Edit View Project |Device Tools Window Help = omrr—)

« = S
JJ DEegd o o =) 2dd Device... F5 o

=4 Remove Device

Device
Computer &5 Properties F&

N I=] PC Based CAN

Context Menu

Description
(K\taser CAN Channel on this computer

4. Select a CANMonitor device by again clicking Device - Add Device, and select
CANMonitor.

“@l File Edit View Project | Device Tools Window Help SPCAN Monifor
— %CCP Controller Device

JJ D Dq. -'\ E ﬁ @ %%L % %XCPController Device

: B kwP2000 CAN Device (Flash Only)
= Remove Device

T
eTWor
Computer =S| Properties F&

; % IPETRONIK DAQ Metwork
=~ E PC Based CAM

=] Context Menu

Description
IVCAN bus message monitor virtual device
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5. Add the .dbc file generated from the ECM Configuration Tool to CANMonitor by clicking
Device - Add CAN Database and browsing to the previously created .dbc file.

Lookn: |}, VISION Projects ~| = ®EckEr

JJ@ Eile Edit View Project | Device Toels Window Help

" [ 2dd CAN Database... =1 Heme Dofc modied __| Tyee
D lddg s o =Ee ‘ || Samples 9/29/20113:18 PM  File folder

=] Remove Device ) {7 LambdaCANTest.dbc 9/30/2011 5:27PM  DBC File

Device

Computer & Properties Fo

- WIS2 PC Based CAN

= WIE? KvaserChannel CANMonitor »

BETEY Chtiiorvcr orre

1 M

File name: ILambdaC.»‘\NTest.dbc

Files of type |CAN Database Files (*.dbe:"uef)

6. Enable the hardware by clicking Project = Online. The status of all of the devices should
now show a Status of Online, and a value should appear in the Data Rate column of the
Project window.

JIEI File Edit View | Project Device Tools Window Help

|D % oo ! CENEEEECE - |

2 \ehicle Manager...
Device fus

’ Computer Proposed Values » line
= w52 PC Based C/ ne
= W52 KvaserT| M Panic Apply Base F12 ne
= WIS2 CANMGHTET THtline

e e hcte
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7. To view data, create a new Screen File and add a Control. Click File > New - Screen File

inle View Tools Window Help

O ([ & e 6 6 o |
Open... Ctrl+0

=
& Import and Export... Ctrl+Q

Recent Projects
Recent Screens

Recent Files

Exit

8. Select Object > Add Control - Gauge

ile Edit View Project | Object Dataltern Tools Window

@ Delete Ctrl+Delete

Tile controls

m Cut
Copy
Paste

B Properties F&

|

DEeR@ =

Ctrl+F10

Context Menu
Track Residency
5] Clear Residency

(5] Project File
®Estrateqy File

®EEMY configuration File
ﬁ Calibration File

[ kaMm Data File
Screen File

L) ASCIT Text File
gRTF Document File

Description
VISION real-time document used for interacting with data

EData List

BB stripchart Recorder

E=12D Table Grid
[E 30 Table Grid
E5tate Array
(% Gauge

1 Bar Graph

:i, Thermometer
@ LD

aLED Array
5 Seroll Bar
Oypial

i Switch

% Dashboard
CAN Trace

"Descripﬁon

Gauge
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9. In the Select Data Items window open the CANMonitor file tree to view all of the available
signals. Here the O2% from Node 0x10 has been selected. Click OK to add the Data Item to
the Control.

' Select " Find

I Advanced. .. | OF I

[C1 DatakemGroups Data Item / | Type | Cancel |
=[] CANMonitor

- E-&D Node_(x10
i -4 Emergency_Ix10

B4 Heartbeat_(x10 - |
52 TPDO1_(k10 =

o LAM_0x10 CAN Signal
CAN Signal Help

] TPDOZ_(10 Previous |

R —

Selected Data ltems I Comments

Add |
Remove |

10. Data should be visible on the gauge.

| @ ATIVISION V3,62 - [Scre

JJ File Edit View Project Object Dataltemn Tools Window Help

DEddF S % [sBEEXbo o AREQAQ L | aREH S

02_0x10 (%)

%  CANMonitorProject
JJIDefauItVehicIe ;IHT‘TJ|@ n |B| B JJ‘/‘H-EH@&?@?@?QAqu. .
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Appendix E: LOCKing and unLOCKing dashCAN*

When dashCAN* is locked, its setup cannot be modified.
¢ To LOCK dashCAN*

Press SYS until “MOd” is displayed.
Press ¥ until “CONE” is displayed. Then press ENT.
Press ¥ until “LOCK” is displayed. Then press ENT.

“50” will be displayed. Press T until “60” is displayed. Then press ENT.
dashCAN™* is now LOCKed.

Ll A

& TounLOCK dashCAN*

1. Press SYS until “LOCK” is displayed. Then press ENT.

2. “50” will be displayed. Press T until “60” is displayed. Then press ENT.
dashCAN* is now unLOCKed.

If an unauthorized person learns that 60 is the key number, contact ECM.
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Appendix F: Examples of Use

This example shows a light duty diesel truck with a DPF and 70,000 km getting on and
driving on the highway. PM sensor mounted tailpipe-out.

pmCAN
25
20
.'g 15
£ 10
5 n
0 4 T ¥ T 1
0 50 100 150 200 250 300 350 400
Seconds
Pegasor PPS-M Particulate Sensor
25
20
™ 15
s
E 10
5 ML&M:\&MM
0
Q 50 100 150 200 230 300 350 400
Seconds
Throttle Position
50
40
E 30 fnw Mﬁ '—nw ‘ %‘\I'
bl
S 20 ! N
JU L Uy
10
ﬂ T T T T T L) T 1
Q 50 100 150 200 230 300 350 400
Seconds
Vehicle Speed
140
120
100 /‘-'/-_ N A TN
£ 80
E 50 P ™ /
20 / AN
0 / WASA"Y/
o LN RV v , | , , ,
0 50 100 150 200 250 300 350 400
Seconds
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This example shows a light duty diesel truck with a damaged DPF getting on and driving on
the highway. PM sensor mounted tailpipe-out.

pmCAN
100
80
M 60
3 I
E a0 L %
JOe.| Ca ko gt
500 550 600 650 700 750 200 850 900
Seconds
Pegasor PP5-M Particulate Sensor
100
80
% 60
E 40
20
0 T T T
500 550 600 650 J00 730 800 850 900
Seconds
Throttle Position
50
40
30 L

Percent
=
<

500 550 600 850 700 730 800 850 900
Seconds

Vehicle Speed

140
120
100 A_-___f w
= a0 / \
£ / 1
E a0
20 f
o AV |
) SN | | | | | |
500 550 500 650 700 750 800 850 300

Seconds
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Appendix G: Cleaning the PM Sensor

Cleaning the PM sensor should take less than 5 minutes and will not affect the calibration.

This is the PM Sensor Cleaning Kit, P/N 14-15. The thin wrenches are key.

PP PR PR Ry B R
22

You will need some extra things to clean a sensor: a roll of paper towels, a can of brake
cleaner (or acetone), a pair of scissors, and compressed air.
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First step is to remove the outer shell. Sometimes it’s a little sticky. Go easy.

|

Then remove the ground electrode:
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Here’s the high voltage electrode. Do not try to remove it. It should be centered in the body
of the sensor, straight, and not loose. If it is not so, you will have to send the sensor back to
ECM. Note the soot pattern.

Spray some brake cleaner on a piece of paper towel and wipe off the side and end of the high
voltage electrode.
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Then blow dry air on the electrode and the annulus between the electrode and the body of the
sensor. You need to remove all the towel’s particles, PM particles, and evaporate the solvent.
Normally, you do not have to clean in the annulus. If you do, you can use a g-tip soaked in
brake cleaner. Do not just spray all over the sensor body with brake cleaner. Always use a

paper towel or g-tip.
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Now spray some brake cleaner inside the ground electrode and clean the inside of the
electrode with a small piece of paper towel soaked in brake cleaner. Sometimes you’ll also
want to use the brush but most of the time, the soaked paper towel will be sufficient.
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Clean the outside and bottom of the ground electrode with a clean part of the towel, and blow
it out with compressed air. It should be clean inside, outside, and all those little holes should
be clean too.
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During your cleaning and blowing, keep away from the teflon tape. Rarely will it need to be
replaced. This is when it is flaking off. Cut off any little loose pieces that are waving around
in the wind because they will cause jumpy PM readings.

If you have to replace the teflon tape, carefully clean the old tape completely from the treads,
cut the tape to the width of the threads and wrap the tape tightly and clockwise around the
threads once and overlapping by a few mm. The tape is wrapped on the threads in a
clockwise direction so that when it is installed into the sensor body, it does not unravel.
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Now clean the outer shell. Again, sometimes you’ll want to use the brush but most of the
time, a brake cleaner-soaked piece of paper towel is sufficient. Blow it out with air after
cleaning.

L) oy
X . Fg
. L4 .

» v,
o
A . P i
G g

y IR
XL

:

X

o
:

A4
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Time to reassemble the sensor. First screw in the ground electrode by hand and snug it down
a bit with the wrench. Do not overtighten. Actually, the main purpose of the wrenches is to
take the sensor apart so don’t overtighten and strip the threads when reassembling.

Then screw on the outer shell. Again, be easy with the wrench! Don’t ask us for torque
targets; you’re not going to run out and buy a tiny custom torque wrench and it’s not critical.
Just be easy and don’t strip the treads.
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Holes look clean? You didn’t drop the sensor, did you? The annulus should be even around
the ground electrode (i.e. everything should be symmetric and centered).

Blow it out one more time. Yes, there is a lot of blowing out. You need to clean out flakes
of soot, pieces of paper towel, and to evaporate any solvent. We recommend using DRY air.
We attach one of those in-line air line desiccant dryer filters to the entrance of our spray
nozzle. You can get those from a good auto parts or paint shop.

Lastly, attach the sensor to the pmCAN cable and electronics and see if the sensor shows low
PM, PN, IST, and ILK numbers when the sensor is held in air. Note that VHV is at about
1000V.

33
fIIY

module with the new NID.

TPDO: Data transmitted by module
TPDO2 [v TPDO3 [v
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E CM ENGINE CONTROL 5191 Lafayette St.
Santa Clara, CA 95054
AND MONITORING USA

Phone: (408) 734-3433
FAX: (408) 734-3432
Email: sales@ecm-co.com
Web: www.ecm-co.com

EC DECLARATION OF CONFORMITY

We declare under our sole responsibility that the products:

AFM1540 Lambda Module

AFM1600L, AFM1600D Modules

DI1S1000 Display head

EGR 4830 Analyzer

NOx 5210 NOx Analyzer

Lambda 5220 Lambda Analyzer

EGR 5230 EGR Analyzer

NOX/NH3 5240 NOx and NH3; Analyzer

NH; 5250 Analyzer

miniSOOT 5260 Analyzer

LambdaCAN, LambdaCANc, LambdaCANd, LambdaCANp Lambda Modules
NOx 1000, NOXCAN, NOXCANg, NOXCANt NOx Modules
NH3;CAN Module

pmCAN

baroCAN Module

dashCAN, dashCANCc, dashCAN+, dashCAN2

appsCAN

SIM200, SIM300, SIM400, SIM500, SIM600, SIM700, SIM800
BTU200

miniPEMS, miniPEMS2, PEMShen

To which this declaration relates are in conformity with the essential requirements of the following standards:
EN61326: 1997/A2: 2001 (Class A & Annex A)
EN61010-1: 2001 (Electrical Safety)

And therefore conform to the requirements of the following directives:

89/336/EEC Electromagnetic Compatibility (EMC)
72/23/EEC Low Voltage Directive (LVD)

Ronald S. Patrick

Vice President Sales
September 2, 2019
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